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Acesso à página do Mendeley

Acesse a página mendeley.com, e clique em Download, à direita no menu 

superior.



Download do Mendeley Desktop

Na página Download, clique no botão indicado para baixar o Mendeley Desktop 

para o sistema operacional do seu equipamento: Windows, MAC OS ou Linux. 

Quando surgir a janela pop-up para download, faça o download do programa.



Criar registro/conta/perfil no Mendeley

Enquanto aguarda o download, você pode criar sua conta de registro no Mendeley, indicando 

nome e e-mail. Se pretende usar o Mendeley para criar grupos com outros pesquisadores, ou 

com finalidade de rede social acadêmica (inclusive seguir e ter seguidores), deixe seu perfil 

completo para melhorar a interação. Mais informações sobre perfil no Blog Mendeley.

•

https://blog.mendeley.com/category/mendeley-profile/


 Atalho e login

Quando o download terminar, clique no arquivo baixado e aceite as 

condições para poder instalar o Mendeley. Após completar a 

instalação, na área de trabalho surgirá o ícone de atalho ao Mendeley 

Desktop. 

Quando clicar no atalho, 

surgirá a tela de login para 

acesso (imagem ao lado 

direito).



INTEGRANDO TEXTOS AO MENDELEY



Criando pasta monitorada para integração automática

Para vincular a pasta, há 2 

opções, no menu superior, 

clicando em:

 1) “File” > “Watch folder” 

OU

2) “Tools” > “Options”.

Serpa aberta uma nova 

janela, e na aba “Watched 

folders”, localize a pasta 

que será usada e depois 

clique em “Apply” e “OK”.

Para melhor organizar os arquivos que integrará ao Mendeley, você pode usar o recurso de 

pasta monitorada. Todos os textos que nela constar serão automaticamente integrados ao 

Mendeley, e você não precisará ficar adicionando aos poucos. Para exemplificar, criamos uma 

pasta no Desktop, com nome “Mendeley_pasta monitorada”.



Fazendo upload de textos de sua autoria
Você pode incluir textos de sua autoria na parte “My publications” também.



Inserindo dados de referências manualmente
Você pode incluir dados de textos que não tenha conseguido integrar, ou que não tenham formato 

eletrônico. Clique, no menu superior, em “File” e depois em “Add entry manually”, para criar uma 

referência manual (imagem à esquerda) na janela que aparecerá a seguir (imagem à direita).

Inclua todos os dados que tiver do item que 

inserir manualmente, para a referência ficar o 

mais completa possível.



Exportando arquivo RIS do Portal de Periódicos da CAPES

Exporte clicando em “Exportar em formato RIS” e salve o arquivo. 

Para integrar o arquivo ao Mendeley Desktop, veja próximo slide.



Importando arquivo RIS para o Mendeley Desktop

1) clique em “Add” > 

“Add files” 

(destaque em 

laranja, ao lado), e 

na janela que abrir, 

localize o arquivo 

onde o salvou e 

clique nele para ser 

integrar as novas 

informações à lista 

de textos; 

OU

2) utilizando janelas lado a lado, selecione os arquivos onde estão (HD, HD externo ou pendrive), e, com 

ajuda do mouse, direcione-os para a parte central da janela do Mendeley (destaque em azul), como se 

os “arrastasse” de um local para o outro.

Depois, dentro do Mendeley Desktop, faça de uma das formas:



Exportando do Pesquisa Integrada Unesp

Utilizando o Pesquisa Integrada 

Unesp você pode integrar dados de 

livros físicos, por exemplo, sem 

precisar usar o Mendeley Web 

Importer.

No Pesquisa Integrada Unesp, clique no título do item descrito no registro que deseja exportar, para abrir a 

janela pop-up com opções de integração (acima), e depois clique na opção Mendeley (destaque com círculo em 

azul). Confirme sua identidade do Mendeley quando solicitado, se preciso autorizando aparecimento de 

pop-ups de confirmação, para que seja os dados do item sejam integrados à sua conta Mendeley (confirmação 

da exportação dos dados no destaque abaixo, em azul). 



Quando for usar novamente o computador onde o Mendeley Desktop estiver instalado, 

clique em “Sync” (destaque em círculo azul), para poder sincronizar os textos que você 

selecionou durante a navegação na internet. 

Destacamos abaixo o texto integrado utilizando o Pesquisa Integrada Unesp (em roxo).

Sincronizando os textos integrados

Se preciso classifique os textos pela coluna que registra a data de integração, para 

visualizar as adições recentes (coluna destacada com a seta em vermelho), resultantes 

da última integração.



Exportar diretamente de páginas com o Mendeley Web Importer 

Para integrar dados de páginas diretamente pelo navegador de internet ao Mendeley, quando 

não estiver navegando em um catálogo ou base dados que possibilitem exportação direta, 

você pode instalar o Mendeley Web Importer para auxiliá-lo nessa exportação de dados.

Você poderá decidir pela instalação via Mendeley 

Desktop (imagem abaixo), clicando em “Tools” e 

depois em “Install Web importer” (destaques em azul), 

que o Mendeley fará o direcionamento à página de 

download do Mendeley Web Importer.

Ou acessar pelo navegador a página do 

Mendeley Web Importer (link), que 

identificará seu navegador e oferecerá o 

link para download adequado ao 

navegador.

https://www.mendeley.com/reference-management/web-importer


Configurando o Web importer

    Caso o ícone do Mendeley         não esteja aparecendo na barra de ferramentas do navegador, 

será preciso fazer essa permissão nas configurações do navegador, em “Extensões”, para que 

possa aparecer.

Para utilizar o 

Mendeley Web 

Importer, é 

preciso permitir 

acesso a todos 

os dados de 

navegação, 

inclusive em 

janelas 

privativas. 



Utilizando a aba do Mendeley Web Importer

Com o Mendeley Web Importer, você conseguirá salvar os dados dos textos que lhe 

interessam diretamente no navegador, clicando no ícone (destaque em roxo), e, após 

seleção, no botão “Add” (destaque em azul).

Os conteúdos adicionados serão posteriormente sincronizados com o Mendeley Desktop, 

como ilustramos no slide a seguir.



Sincronizando com o Mendeley Desktop

Quando acessar novamente o Mendeley Desktop,

 faça a sincronização para haver integração com os textos incluídos online com o Mendeley 

Web Importer, clicando em “Sync” (em laranja).



Acesso online à sua coleção de textos integrados
Acesse a página mendeley.com, e logando em “Sign in” com seu registro/conta/perfil de usuário, em 

“Library” (destaque com círculo em roxo) você pode visualizar os textos que foram integrados até o 

momento. Poderá também organizá-los: atribuir estrelas (destaque com círculo em azul), gerenciar pastas 

(destaque em verde), checar os adicionados recentemente (destaques quadrados em vermelho), etc.



DESCOBRINDO TEXTOS RELACIONADOS

AOS JÁ INTEGRADOS AO MENDELEY



 Buscando textos relacionados

Selecione com o mouse o texto que tiver 

interesse para buscar textos relacionados, e 

depois clique no botão “Related”, para 

localizar mais textos que o Mendeley 

considera semelhantes/interessantes.

Os textos semelhantes serão mostrados numa lista, como a indicada abaixo.



 Salvando textos relacionados

Analise as opções oferecidas, e caso alguma lhe pareça interessante, é preciso salvá-la para que 

continue relacionada no próximo acesso ao Mendeley. Os textos apresentados que não estiverem 

entre os já relacionados, serão salvos somente se forem incorporados. 

Para integrar apenas 1 deles: selecione com o mouse e clique em “Save Reference” para 

adicioná-lo; para integrar mais de um, selecione com o mouse e mantenha pressionada a tecla 

Control (CTRL) para selecionar mais opções, e depois clique em “Save references”.

Para localizar os textos adicionados recentemente, em “My library” > “All documents” > “Recently 

added”:



ORGANIZANDO OS TEXTOS INTEGRADOS



Criar pastas para organizar os textos integrados

Você pode criar pastas para melhor 

organizá-los:

● em “Folders” (destaque em verde), 

clique no botão com sinal positivo 

em “Folders” (destaque em azul), 

digitando a seguir o título que 

deseja dar à nova pasta; 

OU

● em “My library” (menu à esquerda, 

destaque em roxo), clique na opção 

“Create folder”, digitando a seguir o 

título que deseja dar à nova pasta.

Em “All documents” você conseguirá visualizar todos os textos que integrar ao Mendeley. 



Transferindo para pastas

Basta arrastar os documentos desejados para as pastas criadas (clique no documento, 

mantendo pressionado, e com o mouse, solte apenas quando chegar à pasta de destino), 

e expostas no menu à esquerda.

Confira o conteúdo disponível em cada pasta clicando na pasta.



Atualizar informações vinculadas aos textos

Selecione um texto ou vários, e, clicando com botão direito do mouse sobre ele(s), você terá 

opções diversas. À direita da lista de textos há as informações disponíveis sobre cada um.

 Destacamos a opção “Update details” (em laranja), ao clicar sobre o texto com botão direito 

do mouse, para atualizar/completar informações que faltam ou estão erradas (destaque em 

verde).



Completar ou corrigir informações manualmente

Se a atualização não trouxer informações complementares, mantendo-as incompletas ou 

incorretas, você pode editá-las na parte à direita, digitando-as para completá-las, como no 

exemplo abaixo, onde corrigimos título do periódico, completamos informações de volume e 

número/fascículo, que não constavam (destaque em roxo).



Campos por tipo de documento

Para editar os campos de exibição conforme o tipo de documento no Mendeley Desktop, 

você deve clicar em “Tools” > “Options”.

Na nova janela, na aba “Document details”, selecionar o tipo de documento e selecionar 

os campos que deseja expor para cada tipo. 

Ao final escolha “Apply”.



Conferindo detalhes dos documentos

Como já informamos, Mendeley traz campos diferentes conforme o tipo de documento, e 

acrescentamos o campo “City”, que não estava exposto (destaque em roxo), ao padrão para 

artigos de periódicos, para que fique exposto o nome da cidade de publicação, mesmo que 

esse dado esteja vazio quando migramos um arquivo.

Quando o arquivo com o texto está disponível, clicando duas vezes sobre o título ele é aberto 

para leitura, e à direita as informações essenciais disponíveis continuam expostas, na aba de 

detalhes dos documentos (destaque em verde - clique na seta se essa aba estiver oculta).



Visualizando todos os textos integrados

Você pode visualizar os dados dos textos integrados ao Mendeley Desktop de duas formas: 

1. “Library as a table” (lista com autor, título e data): menos detalhada

2. “Library as citations” (lista com as referências completas): mais detalhada



CITAÇÕES E REFERÊNCIAS COM MENDELEY



 Adicionando plugin ao Word ou Writer

Para poder iniciar as citações utilizando o editor de texto instalado no computador, é 

preciso ter adicionado o plugin do Mendeley Desktop. No menu superior, em “Tools”, 

escolha “Install LibreOffice Plugin” ou “Instal MS Word Plugin”, conforme o editor que 

tiver instalado. Na janela que se abrirá em seguida, será confirmada a instalação.

Se tiver o Word apenas com acesso online (2016, Office 365 e para iPad),

será preciso baixar o Mendeley Cite para poder integrar ao Mendeley 

(mais informações nesta página).

https://www.mendeley.com/reference-management/mendeley-cite


 Barra de botões

Após a adição do plugin do Mendeley, ao abrir o editor de texto você terá esses botões 

entre as opções na barra de ferramentas.

Você pode habilitar e desabilitar a exibição 

dos botões do Mendeley no Writer, 

seguindo essa sequência no menu 

superior, como exposto ao lado (destaques 

em azul): 

1. “Exibir” > 

2. “Barra de ferramentas” > 

3. “Mendeley”.



Definindo estilos de citações e referências

O programa já traz vários estilos em seu banco de dados, e se o desejado estiver entre os 

disponíveis, é só selecionar.

Para incluir um estilo ainda não existente, como o ABNT, que devemos usar nas 

dissertações e teses dos nossos programas, é preciso adicionar esse estilo manualmente, 

buscando alguma opção em “More styles”.



Buscando estilos com padrões ABNT

Na nova janela, na aba 

“Get more styles”, 

busque por ABNT para 

checar opções 

disponíveis (repare que 

há opções entre 

autorias abreviadas e 

autorias completas).

Decida por pelo menos 

uma opção: clique nela 

para selecionar e depois 

no botão “Install”. 

A NBR 6023, que traz padrões para referências, foi atualizada em 14/11/2018, 

então estilos de data anterior podem não trazer todas as atualizações 

necessárias para referências nesses padrões 

(destaque em vermelho para a data do estilo selecionado).



Comparando estilos com padrões ABNT

Veja como as informações podem mudar conforme o estilo escolhido (comparamos 5, e 

sublinhamos as desejáveis), considerando as poucas referências que escolhemos:

1. “Disponível em” x “Available in”, mesmo escolhendo o português como idioma das 

citações (dados de acesso online devem ficar no idioma de redação do texto; dados 

anteriores devem ficar no idioma do texto);

2. Organização interna cronológica x alfabética das referências de mesma autoria;

3. Inclusão de campo cidade, que nem sempre traz dados; quando sem dados, 

variação entre ausência x presença de [S. l], e em itálico, conforme padrão vigente;

4. Abreviação dos nomes e sobrenomes anteriores ao último, ou não-abreviação;

5. Presença ou ausência de aspas duplas em títulos de textos que não tenham aspas 

duplas originalmente nos títulos;

6. Menção x ausência de DOI;

7. Inclusão de referências também em notas de rodapé.



 Adotando um estilo com padrões ABNT
Você pode incluir vários estilos ABNT, para testar e depois comparar e decidir qual é o mais 

adequado. Depois de instalado mais de um estilo, você pode decidir por um deles e clicar em 

“Use this style” para torná-lo o padrão no seu gerenciador. Para fazer isso depois de comparar 

estilos, siga esse caminho no programa:

Selecione se o estilo que irá adotar, clicando sobre ele e depois no botão “Use this style”, definindo, 

na parte destacada em laranja, se será aplicado em todos os documentos ou apenas para páginas 

web, e também o idioma para citações e referências. Clique em “Done” para aplicar essas seleções.

1. menu superior >

2. aba “View” >

3. opção “Citation style” > 

4. opção “More Styles” >

5. aba Installed” >

6. caixa de busca: digite 

ABNT



 Inserindo uma fonte de citação

Onde quiser inserir a fonte da citação no 
editor de texto (exatamente onde ficar o 
cursor), clique em “Insert citation”, se 
abrirá uma pequena janela com opção de 
busca de texto pela autoria, título ou ano 
(imagem ao lado direito), para poder 
digitar a informação que tem para o texto 
que deseja buscar. 
Localize a opção certa entre as que 
aparecerem e depois em “OK”.

Acima exemplo de como fica a fonte de citação 
gerada (destaque em azul), com as informações 

adicionadas na janela de edição 
(destaque em laranja).

Para iniciar a redação das citações no texto que está editando, clique no botão “Choose citation style”, para 

que seja selecionado/confirmado o estilo de sua preferência entre todas as opções disponíveis. 

Se quiser adicionar à fonte de citação a indicação de 
página ou outra informação complementar (como 
tradução nossa, grifo nosso etc.), após incluir a 
fonte, clique sobre ela para que fique azul e se abra 
janela de edição (imagem ao lado esquerdo). 

Em “Page” digite o número da página ou o intervalo 
de páginas (separe com hífen), e clique em “ok”.

Em “Suffix”, indique a informação que desejar, e, 
para que não se misture à indicação de paginação, 
coloque uma vírgula seguida de um espaço antes da 
informação que adicionar nesse campo (ex: , grifo 
nosso).



 Inserindo mais de uma fonte de citação (citação indireta)

Para adicionar mais fontes em um mesmo local, basta continuar buscando os outros 

textos e inserindo-os (considere a ordem alfabética das iniciais de cada fonte - a ordem 

não é cronológica para textos de autoria diferentes, para indicá-los no padrão ABNT), 

para ao final de todas as inserções clicar em “OK”.

As fontes inseridas 

ficarão destacadas 

com fundo cinza, 

para indicar que há 

vínculo interno 

(macro).



Gerando a lista de referências

Após inserir todas as fontes de citação necessárias, você pode gerar a lista de 

referências: posicione o cursor onde quer incluí-la, e, clicando em “Insert 

bibliography”, ela será gerada.



Atualizando a lista de referências

A lista será gerada com os dados que 

estiverem vinculados aos textos, 

conforme o estilo escolhido, com os 

textos que já estiverem incluídos. 

Para escolher ou mudar o estilo 

escolhido, clique em “Choose citation 

style”, e o Mendeley abrirá uma nova 

janela para essa escolha. Clique sobre o 

estilo escolhido com o mouse, depois em 

“Use this style”, e “Done”. O estilo será 

aplicado ao documento aberto. 

Não esqueça de salvar o arquivo sempre 

que atualizar alguma informação.

Sempre que quiser confirmar a atualização da 

listagem (mudança de estilo, retirada ou 

inclusão de novas citações etc.), basta clicar em 

“Refresh” na barra de botões do Mendeley.



LEITURA E MARCAÇÕES 

NO MENDELEY DESKTOP



 Criando destaques ou notas

Para atribuir destaques/grifos e comentários/notas, selecione o trecho a destacar ou 

comentar, e aparecerão 3 opções: 

● apenas grifar/destacar (primeira opção, à esquerda: “Highlight”, em vermelho);

● criar nota (segunda opção, ao meio: “Note”, em verde - o texto também destacado); 

● copiar o texto selecionado (terceira opção, à direita).



 Alterando destaques ou notas

Para alterar as cores de destaques/grifos, 

selecione o trecho a destacar ou comentar, 

e em “Color” altere a cor.

Se quiser deletar o grifo, 

basta clicar em “Delete highlight”.

Para alterar alguma nota, clique sobre ela com o botão 

direito, e em “Edit note” digite o texto que deve ser o 

correspondente à nota.

Se quiser deletar a nota, basta clicar em “Delete note”.



Marcando textos como “favoritos”

Entre os textos que reuniu no Mendeley Desktop, você 

pode destacar seus favoritos, utilizando a estrela como 

marcador: basta clicar na estrela ao lado esquerdo do 

autor do texto que quer destacar como favorito.

Para conferir todos os textos que foram salvos como favoritos, 

basta clicar em “My library”, e depois em “Favorites”.



GRUPOS E COMPARTILHAMENTOS



Como criar grupos

No Mendeley Desktop, você pode 

criar grupos de duas formas: 

1) no menu superior, em “Edit”, 

escolhendo “New group” 

(destaques em laranja) 

OU 

2) no menu lateral esquerdo, em 

“Groups”, clicar em “Create 

group” (destaque em azul).



Nomes, descrições e acessos aos grupos

Caso decida pelo grupo privado, indique 

a seguir os e-mails das pessoas que 

comporão o grupo (imagem ao lado 

esquerdo).

Atribua um nome e uma descrição ao grupo, e 

qual será o acesso do grupo (imagem ao lado 

direito):

● público (aberto a todos), 

● somente para convidados (público mas com 

postagens só de membros autorizados);

● privado (fechado e com compartilhamento de 

PDFs entre membros).



Compartilhar textos pelos grupos

Dentro do Mendeley Desktop você pode “arrastar” os documentos para o grupo criado, 

como na imagem abaixo. O mesmo pode ser feito ao acessar sua conta em mendeley.com, 

como ilustramos no slide a seguir.



Visualizando o grupo no Mendeley.com

Acessando sua conta de registro no Mendeley.com, você pode visualizar o grupo criado 

(destaque em vermelho), ter acesso aos textos já compartilhados nele (destaque em 

azul), ou mesmo adicionar novos texto (círculo em roxo), além de incluir mais convidados, 

renomear o grupo e outras ações possíveis.


